Author Guidelines: Future Medicinal Chemistry

This document outlines how to prepare articles for submission. We recommend you read these guidelines in full before submitting your article or making an article proposal. Authors are also advised to read the separate journal policy document here: http://www.future-science.com/page/authors.jsp

Contents

Click on a chapter to jump to it

Aims and scope: Future Medicinal Chemistry ................................................................. 2
Audience ......................................................................................................................... 2
At-a-glance article formatting checklist ........................................................................ 3
Article types .................................................................................................................. 4
  Editorials, Opinions and Commentaries ................................................................. 4
  Conference Reports ................................................................................................ 4
  Reviews ..................................................................................................................... 5
  Patent Reviews ........................................................................................................ 5
  Perspectives .............................................................................................................. 5
  Special Reports ........................................................................................................ 6
  Product and Technology Reviews ......................................................................... 6
  Research Articles ................................................................................................... 6
  Research Article ..................................................................................................... 7
  Preliminary Communications ................................................................................ 7
  Methodologies ......................................................................................................... 7
  Letters to the Editor ................................................................................................. 4
Article sections ............................................................................................................ 7
Figures, tables and boxes ........................................................................................... 8
Supplementary information ......................................................................................... 9
References .................................................................................................................. 9
Reference Manager style ............................................................................................ 10
Chemical and biological structures .......................................................................... 11
Displaying 3D structures in online version of article .............................................. 12
Copyright .................................................................................................................... 12
**Aims and scope: Future Medicinal Chemistry**

Medicinal chemistry has evolved rapidly into a highly interdisciplinary field, enriched by the collaborative efforts of experts from a wide spectrum of specialist areas, from chemoinformaticians and physical chemists to molecular biologists and pharmacologists. *Future Medicinal Chemistry* provides a monthly point of access to commentary and debate for this ever-expanding and diversifying community. The journal showcases milestones in pharmaceutical R&D and features expert analysis of emerging research—from the identification of targets, through to the discovery, design, synthesis and evaluation of bioactive agents.

There has never been more pressure to produce potent and safe compounds faster and more efficiently. *Future Medicinal Chemistry* offers a forum for the rapid publication of original research and critical reviews of the latest milestones in the field. Strong emphasis is placed on ensuring that the journal stimulates awareness of issues that are anticipated to play an increasingly central role in influencing the future direction of pharmaceutical chemistry. Where relevant, contributions are also actively encouraged on areas as diverse as biotechnology, enzymology, green chemistry, genomics, immunology, materials science, neglected diseases and orphan drugs, pharmacogenomics, proteomics and toxicology.

In addition to its core content of Reviews, Perspectives and Original Research, the journal also features enlightened commentary and opinion on topical areas of debate relevant to academia and industry, as well as conference reports, interviews and more.

Principal themes include:

- Drug-discovery technologies
- Design and synthesis of novel lead compounds
- Computational approaches to synthesis and modelling
- Biophysical techniques for structural characterization
- Overviews of novel therapeutic strategies and emerging targets
- Drug targeting and delivery
- ADME/Tox investigations
- Commentary on science policy, economic and IP issues

**Audience**

The audience for *Future Medicinal Chemistry* consists of research scientists, decision-makers and other professionals. By remaining highly responsive to emerging themes, and providing in-depth analysis of agents of medicinal interest and therapeutic approaches, the journal will act as a valuable reference, not only for medicinal chemists, but for all those interested in the advancement of pharmaceutical science.

Future Science articles have been engineered specifically for the time-constrained professional. The structure is designed to draw the reader’s attention directly to the information they require.
At-a-glance article formatting checklist

Authors should consult the below checklist before formatting their manuscript. Further details on all article sections are given in ‘Article sections’.

<table>
<thead>
<tr>
<th>Sections</th>
<th>Word count range (excluding abstract and references)</th>
<th>Abstract</th>
<th>Defined key terms</th>
<th>Key words</th>
<th>Future Perspective and Executive Summary</th>
<th>Reference limit</th>
<th>Figures and tables permitted</th>
<th>Supporting cover letter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Editorial</td>
<td>1000-1500</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td></td>
<td>20</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Opinion</td>
<td>1000-1500</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td></td>
<td>20</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Commentary</td>
<td>1500-3000</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td></td>
<td>20</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Letter to the Editor</td>
<td>1500</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td></td>
<td>20</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Conference Report</td>
<td>1000-3000</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
<td></td>
<td>20</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Special Report</td>
<td>3000-5000</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td></td>
<td>50</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Perspective</td>
<td>4000-8000</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td></td>
<td>150</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Review</td>
<td>4000-8000</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td></td>
<td>150</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Technology Review</td>
<td>4000-8000</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td></td>
<td>150</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Patent Review</td>
<td>4000-8000</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td></td>
<td>150</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Research Article</td>
<td>5000-8000</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td></td>
<td>150</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Preliminary Communication</td>
<td>3000-5000</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td></td>
<td>50</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Methodology</td>
<td>3000-5000</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td></td>
<td>50</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
Article types

Future Medicinal Chemistry publishes a range of article types, descriptions of which are outlined below. Authors are encouraged to consult the ‘At-a-glance article formatting checklist’ for details on word counts and other formatting requirements.

Editorials, Opinions and Commentaries

Editorials are short articles that provide an insight into, or snapshot of issues of topical importance to the journal’s target audience or researchers and other professionals. The intention is that the article should offer an expert perspective on a topic of recent interest. More detailed discussions can take the form of Commentary articles.

Opinion articles should typically be informed, agenda-setting and authoritative. If addressing a problem, they should also present coherent argued solutions. They can address issues relating to scientific research, or peripheral areas of debate affecting industry and academia of concern to the journal’s scope.

Published example:

http://www.future-science.com/doi/pdf/10.4155/fmc.11.186

Letters to the Editor

Readers may submit Letters to the Editor, commenting on an article published in the journal. Where appropriate, Letters to the Editor will be sent to the author of the original article, who will have 28 days to provide a response for publication. Acceptance of Letters to the Editor for publication is at the discretion of the Editor and Editorial Board.

Conference Reports

Conference reports aim to summarize the most important research presented at a recent relevant meeting or event. It is not usually feasible to attempt comprehensive coverage of the conference; authors should therefore focus on those presentations that are most topical, interesting or thought-provoking.

Published example:

http://www.future-science.com/doi/pdf/10.4155/fmc.11.78
Reviews

Reviews aim to highlight recent significant advances in research, ongoing challenges and unmet needs; authors should be concise and critical in their appraisal of the subject matter, and strive for clarity. The focus should be on key, defining developments rather than providing a comprehensive literature survey. Reviews should provide balanced coverage of the field and not focus predominantly on the author’s own research. Authors are encouraged to include their own perspective on current trends and future directions.

Published example:


Patent Reviews

Patent Reviews should provide an objective and concise appraisal of a selection of patents in a chosen area. Discussions should be placed within the context of the relevant wider R&D landscape. Authors are expected to offer a commentary on the significance, potential and essential content of the patents under discussion. The patents reviewed should be from a variety of companies/assignees, and should be timely (*i.e.*, ideally granted within the past 1-4 years). The majority of the references cited in the article should be taken from the patent literature. Patent Reviews should provide balanced coverage of the field and not focus predominantly on the author’s own research. Where the controversial or novel ideas are presented, opposing viewpoints should be briefly mentioned and appraised. Authors are encouraged to include their own perspective on current trends and future directions.

A separate detailed set of guidelines for writing patent reviews is available for download from this page: [http://www.future-science.com/page/journal/ppa/aims.jsp](http://www.future-science.com/page/journal/ppa/aims.jsp)

Published example:


http://www.future-science.com/doi/pdf/10.4155/fmc.10.294

Perspectives

Perspectives have the same basic structure and length as review articles; however, they should be more speculative and forward-looking, even visionary. They offer the author the opportunity to present criticism, address controversy or provide a personal angle on a significant issue. Authors of perspectives are encouraged to be opinionated, with all positions concisely and clearly argued and referenced. Referees will be briefed to review these articles for quality and relevance of argument only. They will not necessarily be expected to agree with the author’s position.
Published example:


http://www.future-science.com/doi/pdf/10.4155/fmc.09.28

Special Reports

Special reports are short review-style articles that highlight a particular niche area, be it a specific emerging field, novel hypotheses or method. Articles are categorized as Special Reports at the discretion of the Editorial team.

Published example:


http://www.future-science.com/doi/pdf/10.4155/fmc.10.190

Product and Technology Reviews

Product and Technology Reviews are review-style articles that summarize selected instrumentation, techniques or software. The article should clearly highlight the relevance of the products or technology to pharmaceutical chemistry and present an objective perspective on the product(s) under discussion.

Published example:


http://www.future-science.com/doi/pdf/10.4155/fmc.10.244

Research Articles

Authors of original research must provide a supporting Cover Letter on submission briefly detailing:

- relevance to the journal’s audience;
- where the novelty in the study lies;
- direct and potential implications of the findings.
Experimental details and data

Only where a novel experimental procedure has been employed full details must be provided, such that a skilled scientist would be able to reproduce the results presented. The synthesis of all new compounds must be described in detail. Details of routine or previously reported experimental procedures should be provided via references only. Experimental procedures and/or data running to more than two Word document pages should be placed in a supplementary information file.

Published example:


http://www.future-science.com/doi/pdf/10.4155/fmc.09.89

Three categories of research paper are published in the journal:

**Research Article**

Research articles should present novel work that makes a significant impact within the scope of the journal, and which represents an important advancement in knowledge or understanding. Routine or incremental work is not suitable for full research papers. Research should be reported succinctly; the inclusion of detailed background discussion is to be avoided. Supporting data or further experimental details can be submitted as Supplementary Information. If requested by the Editor or reviewers, authors should be able to provide additional relevant original data underpinning their research.

**Preliminary Communications**

Preliminary communication articles are intended for short reports of studies that present promising improvements or developments on existing areas of research. The significance and potential implications of the developments must be explicit.

**Methodologies**

Methodology articles should provide an overview of a new experimental or computational method, test or procedure. The method described may be either completely novel, or may offer a demonstrable improvement on an existing method. The significance and potential implications of the developments must be explicit.

**Article sections**

The following list provides notes on the key article sections; authors should consult the ‘At-a-glance article formatting checklist’ to determine which sections are required for their submission.

**Title:** Concisely and clearly conveys the scope/novelty of the article; not more than 120 characters.
Author(s) names and affiliations: Including full name, postal address, phone and fax numbers, and e-mail address.

Abstract: Not more than 120 words; no references should be cited in the abstract. The abstract should highlight the importance of the field under discussion within the journal’s scope, and clearly define the parameters of the article.

For all Research Articles only, the abstract must be structured into three sections:

- Background: Brief overview of the context, purpose and novelty of the study. Discussion of background science should be kept to a minimum.
- Results/Methodology (as appropriate): a succinct summary of the experimental procedure and key findings; detailed experimental data or explanations of experimental procedures should be submitted as supplementary information.
- Conclusions: A summary of the main conclusions of the study and any implications for the field.

Author photographs: Required for Editorials and Opinion articles only. The corresponding author plus one other author, if desired, can provide a suitable high-resolution head shot for inclusion.

Key words: Required for Editorials, Opinions, Commentaries only; a selection of 5-10 words that encapsulate the scope of the article.

Defined key terms: Required for Reviews, Perspectives and Original Research only; 5–10 key technical terms or concepts that are mentioned in the text for which a short definition or explanation is provided. Key terms enhance the article by providing supplementary or background information and should not repeat details already given in the text. When choosing key terms, authors should consider the readership of the journal and avoid the inclusion of rudimentary definitions.

Reference annotations: Authors can highlight 6–8 references that are of particular significance to the subject under discussion, and provide a brief (1–2 line) synopsis. Please note that footnotes are not permitted throughout the manuscript.

Body of the article: The article content should be arranged under relevant headings and subheadings to assist the reader.

Future perspective: A speculative viewpoint on how the field will evolve in 5–10 years’ time.

Executive summary: Bulleted summary points that illustrate the main conclusions made throughout the article.

Figures, tables and boxes

The use of figures and diagrams is encouraged wherever relevant. The author should include illustrations and tables to condense and illustrate the information they wish to convey. Commentary that augments an article and could be viewed as ‘stand-alone’ should be included in a separate box. All figures, tables and boxes should be submitted in an editable format.
Figures, tables and boxes should be numbered consecutively according to the order in which they have been first cited in the text. All abbreviations used within them should be defined in the legend.

If any of the figures or tables used in the manuscript requires permission from the original publisher, it is the author’s responsibility to obtain this. More details on obtaining permissions can be found in here and in the copyright section below.

**Supplementary information**

Tables, figures and boxes larger than one A4 page will be included as online-only supplementary information. At the Editor’s discretion data or experimental details can also be included.

**References**

- Authors should focus on recent papers; those older than 5 years should not be included except for an over-riding purpose.

- References should be denoted numerically and in sequence in the text, using Arabic numerals placed in square brackets, i.e., [12].

- If websites or patents are included, please use a separate numbering system for them, i.e., start numbering patent references at [101] and websites at [201] to allow the reader to distinguish between websites/patents and primary literature references both in the text and in the bibliography.

- Any references that are cited in figures, tables or boxes that do not appear in the text should be listed at the end of the reference list in the order they occur.

**Reference formatting**

All references should be formatted according to the house style given in the below examples:

**Journals:**


**Journal supplements:**

Books:


Meeting abstracts:


Patents:


Please use the following formats for patent numbers issued by the World, US and European patent offices, respectively: WO1234567, US1234567, EP-123456-A.

Reference annotations:

Authors can highlight 6–8 references that are of particular significance to the subject under discussion as “* of interest” or “** of considerable interest”, and provide a brief (1–2 line) synopsis.

Example:


• Reveals a new strategy for achieving PTP1B selectivity over TCPTP.

Reference Manager style

1. Download the Future Science Reference Manager Style [here](#).

2. Once the file is downloaded to your desktop, copy the file to the appropriate folder in your program directory (usually located in C:\Program Files\Reference Manager\Styles).

EndNote style

Follow the instructions that are appropriate for your version of EndNote as listed below:

Installing the style into EndNote X2 and later versions
1. Download the Future Science EndNote style for references [here](compatible with Mac EndNote 9).

2. In Windows, or using your Macintosh Finder, browse to the location where you downloaded the style. Double-click on the style file to open it. It should open in the EndNote program.

3. In EndNote, go to the "File Menu" and choose "Save as."

4. Remove the word "copy" from the end of your style's name, and then click the Save button.

5. Click on the "File Menu" and choose "Close Style."

**Installing the style into EndNote 8, 9, X, or X1**

1. Download the Future Science EndNote style for references [here](compatible with Mac EndNote 9).

2. Using Windows, or using your Macintosh Finder, browse to the location where you downloaded the style. Right-click on the style file and select Copy.

3. Browse to your Endnote Styles folder. This will typically be in following location: Windows: C:\Program Files\EndNote #\Styles (Where # is the version number for EndNote) Mac OS: Applications\EndNote #\Styles (Where # is the version number for EndNote) Note: If you modify the EndNote preferences, you can set this to another location. To check this setting, go to the "Edit" menu or EndNote menu on the Mac and select "Preferences." Click on the Folder Locations option to see the custom Style folder location and modify as needed. Keep in mind that the default location for the Styles folder may cause problems when trying to save or edit in Windows Vista and 7 with versions prior to EndNote X2. Please see this article for more information on this issue.

4. Right-click in this folder and choose Paste. Your style should now be installed in the EndNote program.

If you require further assistance or have any questions, please contact the Editor.

**Chemical and biological structures**

Authors should submit chemical structures in ISISDraw or Chemdraw formats. Please use the following conventions:

- Always indicate stereochemistry where necessary – use the wedge and hash bond convention for chiral centers and mark cis/trans bonds as such;
- Draw small peptides (up to five amino acids) in full; use amino acid abbreviations (Gly, Val, Leu, etc.) for larger peptides;
- Refer to each structure with a number in the text.
Displaying 3D structures in online version of article

The journal website has functionality to support the Jmol viewer for the display of dynamic, 3D chemical and biological structures. We encourage authors to submit their relevant figures in any of the file formats supported by Jmol - including as MOL and CIF - to take advantage of this on-line functionality. More information on Jmol and the files supported by it, can be found here: http://jmol.sourceforge.net/

A published example can be viewed here: http://www.future-science.com/doi/suppl/10.4155/fmc.10.282/suppl_file/figure6.htm

For more guidance, please contact the Editor.

Copyright

If a figure or table has been published previously (even if you were the author), acknowledge the original source and submit written permission from the copyright holder to reproduce the material where necessary.

As the author of your manuscript, you are responsible for obtaining permissions to use material owned by others. Since the permission-seeking process can be remarkably time-consuming, it is wise to begin writing for permission as soon as possible.

Future Science is a signatory to the STM Permissions Guidelines produced by the International Association of Scientific, Medical and Technical Publishers (http://www.stm-assoc.org/). Permission is, or in the case of an express permission requirement should be, granted free of charge by signatory organizations, with respect to a particular journal article or book being prepared for publication, to:

- Use up to three figures (including tables) from a journal article or book chapter, but:
  - not more than five figures from a whole book or journal issue/edition;
  - not more than six figures from an annual journal volume; and
  - not more than three figures from works published by a single publisher for an article, and not more than three figures from works published by a single publisher for a book chapter (and in total not more than thirty figures from a single publisher for re-publication in a book, including a multi-volume book with different authors per chapter).
- Use single text extracts of less than 400 words from a journal article or book chapter, but not more than a total of 800 words from a whole book or journal issue/edition.

Permission to go beyond such limits may be sought although in such instances the permission grant may require permission fees. Important: although permission may be granted without charge, authors must ensure that appropriate permission has nevertheless been obtained. Co-signatories of the permissions agreement can be found on the following website: http://www.stm-assoc.org/stm-permission-guidelines/.
Please send us photocopies of letters or forms granting you permission for the use of copyrighted material so that we can see that any special requirements with regard to wording and placement of credits are fulfilled. Keep the originals for your files. If payment is required for use of the figure, this should be covered by the author.